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 After completing this lesson, you will be able to: 

  1.   Start Word and identify parts of the Word screen.  

  2.   Key and edit text.  

  3.   Name and save a document.  

  4.   Open an existing document.  

  5.   Move within a document.  

  6.   Select text.  

  7.   Print a document.  

  8.   Close a document and exit Word.    

  Microsoft Word is a versatile, easy-to-use word processing program that 
helps you create letters, memos, reports, and other types of documents. This 
lesson begins with an overview of the Word screen. Then you learn how to 
create, edit, name, save, print, and close a document. The documents you 
create for this unit will provide an overview of Campbell’s Confections, its 
products, and the process of making chocolate.        

 Starting Word and Identifying Parts 
of the Word Screen  
 There are several ways to start Word, depending on your system setup and per-
sonal preferences. For example, you can use the Start button on the Windows 
taskbar or double-click a Word shortcut icon that might be on your desktop.  

 OBJECTIVES 

 Estimated Time: 1½ hours

         Lesson 1 

 Creating and Editing 
a Document   

  TEACH  
 Teaching Resources: 
 This text is supported by classroom 
presentations in a PowerPoint 
format. For this lesson, use Word 
Classroom Presentation 1.   

              PREPARE 
 Point out to students that the 
learning objectives show what 
they will learn in the lesson. Each 
heading in the lesson correlates to 
a learning objective.  

 Required file: Campbell-1. 

A
 Give students instruction about 
starting Word on their computers. 

  OBJECTIVE 1 
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Exercise 1-1      START WORD  

  1.    Click the Start button  on the Windows taskbar, and 
point to  All Programs .  

  2.    On the All Programs menu, click  Microsoft Office , and 
then click  Microsoft Word 2010 . In a few seconds, the 
program loads, and the Word screen appears.                         

 NOTE 

 Your screen may differ from the screen 
shown in  Figure 1-1  depending on the 
programs installed on your computer. 

  Figure 1-1
  Start menu    

Start button

  Figure 1-2
  Word screen    

Quick Access Toolbar

Ribbon tabs

Vertical scroll bar

View buttonsStatus bar Zoom level controls

Rulers

File tab

Ribbon

Title bar

Group

Text area

LESSON 1 Creating and Editing a Document

  Word Classroom 
Presentation 1.  

 If the rulers and scroll bars do not display, click the File tab, and 
click Options. Click Advanced, and scroll to Display. Click the 
options to show the horizontal and vertical scroll bars and ruler. 
Then click OK. Also, verify that the Style Set is Word 2010. Click the 
Change Styles button, click Style Set, and click Word 2010. 

 By default, the active tab on 
the Ribbon is the Home tab. 
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UNIT 1 Basic SkillsWD-4

TABLE 1-1 Parts of the Word Screen

Part of Screen Purpose

Quick Access 
Toolbar

The Quick Access Toolbar is located at the top of the Word window, and its 
commands are available for all tabs on the Ribbon. By default, it displays icons 
for save, undo, and repeat. The Quick Access Toolbar can be customized to 
include commands that you use frequently.

Title bar Displays the name of the current document. The opening Word screen is always 
named “Document1.”

Ribbon Displays contextual tabs. Each tab contains groups, and each group includes related 
commands. Commands can be buttons, menus, or drop-down list boxes.

File tab Displays the Backstage view with options to create, save, open, and close 
documents. You can also display recently opened documents.

Ruler The horizontal and vertical rulers display in Print Layout view. The horizontal ruler 
shows the placement of margins, indents, and tabs. Use the View Ruler button to 
show or hide the rulers.

Text area Displays the text and graphics in the document.

Scroll bars Used with the mouse to move right or left and up or down within a document.

Status bar Displays the page number and page count of the document, the document view 
buttons, and the zoom control. It also displays the current mode of operation. 
The status bar can be customized.

View buttons Used to switch from one document view to another. Available views include Print 
Layout, Full Screen Reading, Web Layout, Outline, and Draft View.

 Exercise 1-2  IDENTIFY THE RIBBON AND 
THE QUICK ACCESS TOOLBAR 

 To become familiar with Word, start by identifying the parts of the screen you 
will work with extensively, such as the Ribbon and the Quick Access Toolbar. 
As you practice using Word commands, you will see  ScreenTips  to help you 
identify screen elements such as buttons. A ScreenTip appears when you point 
to a command on the Ribbon. It includes the name of the command and a 
brief description. ScreenTips also appear to help you identify parts of the 
Word screen. 
  When you start Word, the Ribbon appears with the Home tab selected. 
The Ribbon consists of eight tabs by default. Each tab contains a group of 
related commands, and the number of commands for each tab varies. A 
command can be one of several formats. The most popular formats include 
buttons and drop-down lists. 
  The  Quick Access Toolbar  contains frequently used commands and is 
positioned above the Ribbon by default. You can minimize the Ribbon so 

To place the Quick Access Toolbar below the Ribbon, click the Customize Quick Access Toolbar button on the 
Quick Access Toolbar, and click Show Below the Ribbon. To minimize the Ribbon, click the Minimize the 
Ribbon button (located to the left of the Help button with a caret symbol) or press Ctrl + F1 .
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WD-5LESSON 1 Creating and Editing a Document

that only the names of the tabs display, or you can place the Quick Access 
Toolbar below the Ribbon. The commands on the Quick Access Toolbar are 
available for all tabs on the Ribbon, and you can customize the Quick Access 
Toolbar to include the commands you frequently use.  

  1.    Move the mouse pointer to the  File  tab on the Ribbon. Click the left 
mouse button to open the Backstage view. The Backstage view replaces 
the Microsoft Office Button and the File menu from earlier versions 
of Microsoft Word. It lists commands to create, open, save, and print 
documents. The Navigation Pane appears on the left side of Backstage 
view and includes a list of the Quick commands. Click the  Info  command 
to view information about your document. When a document is open, 
the Info tab displays the document properties such as size, number of 
pages, and number of words. You can also see when your document was 
last modified. 

  Figure 1-3
  Backstage view    

Navigation Pane

   2.   Click the  File  tab to close Backstage view. You can also 
close the Backstage view by pressing Esc  or clicking 
another tab on the Ribbon.  

  3.   Move the mouse pointer above the File tab to the 
Quick Access Toolbar, and point to the Save button  . 
A ScreenTip and a keyboard shortcut to save a 
document display.  

TIP

Commands may appear in more than one 
location. For example, you can save a 

document by choosing Save from the File 
tab, by clicking the Save command on 

the Quick Access Toolbar, or by 
pressing Ctrl + S .

Word Classroom 
Presentation 1.
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UNIT 1 Basic SkillsWD-6

  4.   Point to the commands to the right of the Save 
command. Notice each command includes descriptive 
text and a keyboard shortcut. The Save, Undo, and 
Repeat commands are located on the Quick Access 
Toolbar by default.  

  5.   Move the mouse pointer to the  Insert  tab on the 
Ribbon, and click  Insert . Notice the change in the 
number and types of groups displayed. When you 
point to a Ribbon tab, the name of the tab is outlined 
but not active. Click the Ribbon tab to display the 
commands.  

  6.   Click the  Page Layout  tab. There are five groups of 
commands on the Page Layout tab. Point to the 
 Margins  command. Read the ScreenTip.  

  7.   Click the  Home  tab. Notice the groups and buttons available for 
formatting and editing.  

  8.   Move the mouse pointer to the right of the last tab on the Ribbon, and 
locate the caret symbol (^). This symbol represents a button and is used 
to minimize the Ribbon. Click the Minimize the Ribbon button , and 
notice that only the Ribbon tabs and ruler display. The Minimize the 
Ribbon button changes to Expand the Ribbon button.  

  9.   Click the Expand the Ribbon button  to restore the Ribbon. The 
keyboard shortcut to minimize the Ribbon is Ctrl + F1 . To restore the 
Ribbon, press Ctrl + F1 . You can also double-click any tab on the Ribbon 
to minimize the Ribbon. Double-click a tab to restore the Ribbon.                             

 Exercise 1-3 IDENTIFY COMMANDS 

 Use the Ribbon to locate and execute commands to format and edit 
your document. Commands also control the appearance of the Word 
screen. You can access Ribbon commands by using the mouse or keyboard 
Access Keys.  

  1.   Activate the  Home  tab.  

  2.   Locate the  Paragraph  group, and click the Show/Hide ¶ button . 
    This button shows or hides formatting marks on the screen. Formatting 

marks display for spaces, paragraph marks, and tab characters. The 
command toggles between show and hide.  

NOTE

The width of the application window 
affects the size and shape of the Ribbon 

commands.

NOTE

Any Ribbon command with a light gray 
icon is currently not available. However, 

you can still identify the button by 
pointing to it with the mouse.

The Ribbon adapts to the task. For example, the Insert tab is 
used to add pages, text, shapes, illustrations, or other objects to 
a document. The Home tab contains commands for editing and 
formatting a document.

Enhanced ScreenTips include a link to a Help topic. Press F1  
for Help.

There are also Ribbon tabs that are hidden from view by 
default. For example, the Picture Tools Format tab displays 
when a picture or clip art object is selected. If a picture is not 
selected, the tab does not display. The Drawing Tools Format 
tab displays when a shape is selected.

Point out that Ribbon commands and Quick Access Toolbar 
commands may appear gray. For example, the Cut command on 
the Home tab is gray unless text is selected.
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LESSON 1 Creating and Editing a Document WD-7

     4.   Press the letter P  on the keyboard to select the  Page Layout  tab.  

  5.   Press the letter M  on the keyboard to display the  Margins  gallery. Press 
Esc  to close the gallery. Press Esc  twice to turn off the Key Tips.  

  6.   Locate the vertical scroll bar, and click the View Ruler 
button . Notice the rulers disappear from the Word 
screen. Click the View Ruler button  again to display 
the rulers.  

  7.   Locate the Zoom button  on the status bar.  

  8.    Click the Zoom button to open the Zoom dialog box, 
and click  200% . Click  OK . The text area is magnified, 
and you see a portion of the page.  

  9.   Point to and click the Zoom Out button . The 
document magnification changes to 190%. Click the 
Zoom In button  twice to change the magnification 
to 210%. Drag the Zoom slider  to 100%. The 
document returns to normal display.                   

 Keying and Editing Text  
 When keying text, you will notice various shapes and symbols in the text 
area. For example: 

  •   The  insertion point   is the vertical blinking line that marks the 
position of the next character to be entered.  

  •   The mouse pointer takes the shape of an  I-beam   when it is in the 
text area. It changes into an arrow  when you point to a command 
on the Quick Access Toolbar or the Ribbon.  

  •   The  paragraph mark  ¶ indicates the end of a paragraph. The paragraph 
mark displays when the Show/Hide ¶ button  is selected.     

NOTE

You can also use the View tab on the 
Ribbon to show or hide the ruler.

NOTE

Drag the Zoom slider to the right to zoom 
in, and drag the Zoom slider to the left to 

zoom out. You can also use Ctrl +the 
wheel on your mouse to zoom in and 

zoom out. The View tab on the Ribbon 
contains Zoom commands.

Figure 1-4
Key Tips

Key Tips

  3.   Press the Alt  key. Small lettered or numbered squares, called  Key Tips,  
appear on the File tab, Quick Access Toolbar, and Ribbon to access or 
execute a command. 

Word Classroom 
Presentation 1.

 OBJECTIVE 2

Remind students that once rulers have been turned on, they will be 
available for all documents unless you choose to hide them.
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UNIT 1 Basic SkillsWD-8

 Exercise 1-4  KEY TEXT AND MOVE 
THE INSERTION POINT  

  1.   Before you begin, make sure the Show/Hide ¶ button  on the  Home  
tab,  Paragraph  group is selected. When this feature is “turned on,” you 
can see paragraph marks and spacing between words and sentences 
more easily.  

      2.   Key the words  Campbell’s Confections  (don’t worry about keying 
mistakes now—you can correct them later). Notice how the insertion 
point and the paragraph mark move as you key text. Notice also how a 
space between words is indicated by a dot.  

      3.   Move the insertion point to the left of the word 
“Campbell’s” by positioning the I-beam and clicking 
the left mouse button.  

  4.   Move the insertion point back to the right of 
“Confections” to continue keying.     

Exercise 1-5    WRAP TEXT AND CORRECT SPELLING 

 As you key additional text, you will notice Word performs several tasks auto-
matically. For example, Word does the following by default: 

  •   Wraps text from the end of one line to the beginning of the next line.  

  •   Alerts you to spelling and grammatical errors.  

  •   Corrects common misspellings, such as “teh” for “the” and “adn” for “and.”  

  •   Suggests the completed word when you key the current date, day, or 
month.             

NOTE

The documents you create in this course 
relate to the case study about Campbell’s 
Confections, a fictional candy store and 
chocolate factory (see the Case Study in 

the front matter).

Figure 1-5
The insertion point 

marks the place 
where you begin 

keying

Insertion point

The keyboard shortcut to 
Show/Hide ¶ is Ctrl + * .

Remind students that text to be 
keyed is shown in red.

Word Classroom 
Presentation 1.

With automatic spell checking and grammar checking both turned on (by default), students will probably 
encounter red, blue, and green wavy lines as they key text. Students will also likely encounter AutoCorrect and 
AutoComplete. Alert students to these features, and advise them that they will be discussed later in the course.

hin19294_ch01_WD001-WD047.indd Page WD-8  26/04/10  3:30 PM user-f467hin19294_ch01_WD001-WD047.indd Page WD-8  26/04/10  3:30 PM user-f467 /Volumes/203/MHRL033/ros69760_disk1of1/0070969760/ros69760_pagefiles/Volumes/203/MHRL033/ros69760_disk1of1/0070969760/ros69760_pagefile



LESSON 1 Creating and Editing a Document WD-9

  1.   Continue the sentence you started in Exercise 1-4, 
this time keying a misspelled word. Press Spacebar , 
and then key  is western Pennsylvania’s leeding candy 
maker  (don’t key a period). Word recognizes that 
“leeding” is misspelled and applies a red, wavy 
underline to the word. The status bar displays a 
Proofing Errors icon  to indicate an error exists 
in the document.  

  2.   To correct the misspelling, use the mouse to position the I-beam 
anywhere on top of the red, underlined word and click the  right  mouse 
button. A shortcut menu appears with suggested spellings. Click 
“leading” with the  left  mouse button. The misspelled word is corrected. 
Notice the change in the icon that displays in the status bar. The 
Proofing Errors icon  changes to a No Proofing Errors icon  on 
the status bar. 

TIP

The Proofing Errors icon  at the left 
side of the status bar displays an “x” 

instead of a checkmark when it detects an 
error. When the error is corrected, the “x” 

is replaced with a checkmark.

Figure 1-6
Choose the correct 
spelling from the 

shortcut menu

Proofing Errors icon indicates the 
document contains an error.

Shortcut menu

Mini toolbar

   3.   Move the insertion point to the right of “maker,” and press Spacebar . 
Continue the sentence with another misspelled word by keying  adn , and 
press Spacebar . Notice that “adn” is automatically corrected to “and” 
when you press Spacebar .  

Word Classroom 
Presentation 1.

Reinforce the concept of text wrapping. 
Make sure students understand that 
they don’t have to press Enter  at the 
end of a line.

The Mini toolbar automatically displays 
when text is selected. The Mini toolbar 
is used to format selected text.
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  4.    Complete the sentence by keying  is located in Grove City on Main Street .  

  5.    Verify that the insertion point is to the immediate right of the period 
following Street, and then press the Spacebar  once. Key the following text: 

      It is a family-owned business with several stores 
located in western Pennsylvania, eastern Ohio, and 
northern West Virginia.  

     Notice how the text automatically wraps from the end 
of the line to the beginning of the next line.  

  6.   Press Enter  once to start a new paragraph.  

  7.   Key the second paragraph shown in  Figure 1-7 . When 
you key the first four letters of “Monday” in the first 
sentence, Word suggests the completed word in a 
small box. Press Enter  to insert the suggested word, and 
then press Spacebar  before you key the next word. 
Follow the same procedure for “Saturday.”     

                Exercise 1-6 DELETE TEXT 

 The keyboard offers many options for basic text editing. For example, you 
can press Backspace  to delete a single character to the left of the insertion 
point or press Ctrl + Delete  to delete an entire word.            

TABLE 1-2 Basic Text Editing

Key Result

Backspace Deletes the character to the left of the insertion point.

Ctrl + Backspace Deletes the word to the left of the insertion point.

Delete Deletes the character to the right of the insertion point.

Ctrl + Delete Deletes the word to the right of the insertion point.

NOTE

Throughout this text, one space is used 
after a period to separate sentences. This 

is the standard format for word 
processing and desktop publishing.

NOTE

When Word suggests a completed word 
as you key text, you can ignore the 

suggested word and continue keying or 
insert it by pressing Enter .

Figure 1-7
For more information about Campbell’s Confections, visit one 
of our stores Monday through Saturday, or visit our Web site 
anytime. Our sales associates will be happy to assist you.

The default paragraph format 
for the normal template 
includes 10-point spacing after 
and 1.15 line spacing. 
Consequently, students are 
asked to press Enter  once to 
start a new paragraph.

The characterization of using one space after a period as 
“the standard for word processing and desktop publishing” 
might strike students who are used to keyboarding classes 
as radical. Explain that with proportional fonts and 
justification, the use of a double space after a period (or 
colon) can make documents look unprofessional. You might 
want to demonstrate the problems of using two spaces after 
a period. State your policy in relation to using two spaces 
after a period in documents for this class.

Review keyboard 
combinations with students. 
Make sure they master this 
skill and understand how it is 
represented in this text (using 
the plus sign).
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LESSON 1 Creating and Editing a Document WD-11

  1.   Move the insertion point to the right of the word “It” in the second 
sentence of the first paragraph. (Use the mouse to position the I-beam, 
and click the left mouse button.)  

  2.   Press Backspace  twice to delete both characters, and key  Campbell’s 
Confections .  

  3.   Move the insertion point to the left of “one” in the second paragraph.  

  4.   Press Delete  three times and key  any .  

  5.   Move the insertion point to the left of the word 
“information” in the second paragraph.  

  6.   Hold down Ctrl  and press Backspace . The word “more” is 
deleted.  

  7.   Move the insertion point to the right of “Grove City” in 
the first sentence of the first paragraph.  

  8.   Hold down Ctrl  and press Delete  to delete the word 
“on.” Press Ctrl + Delete  two more times to delete the 
words “Main Street.”    

            Exercise 1-7     INSERT TEXT 

 When editing a document, you can insert text or key over existing text. When 
you insert text, Word is in regular  Insert mode,  and you simply click to 
position the insertion point and key the text to be inserted. To key over 
existing text, you switch to  Overtype mode.  The Overtype feature is turned off 
by default.  

   1.   In the first sentence of the first paragraph, move the insertion point to 
the left of the “G” in “Grove City.” Key  downtown , and press Spacebar

once to leave a space between the two words.  

   2.   Move the insertion point to the beginning of the document, to the left of 
“Campbell’s.”  

   3.   Click the  File  tab, and click the  Options  command.  

       4.   Click  Advanced  in the Navigation Pane of the Word Options dialog box. 
Locate  Editing options , and click to select  Use overtype mode . 
Click  OK .  

   5.   Press Caps Lock . When you key text in Caps Lock mode, the keyed text 
appears in all uppercase letters.  

   6.   Key  campbell’s confections  over the existing text.  

NOTE

When keyboard combinations (such as 
Ctrl + Backspace ) are shown in this text, 

hold down the first key as you press the 
second key. Release the second key, and 
then release the first key. An example of 
the entire sequence is this: Hold down 

Ctrl , press Backspace , release Backspace , 
and release Ctrl . With practice, this 

sequence becomes easy.

The Word Options dialog box, Advanced 
command, Editing Options group includes an 
option to use the Insert key to control overtype 
mode. You may want to demonstrate this option.
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UNIT 1 Basic SkillsWD-12

   7.   Move the mouse pointer to the status bar, and press the right button on 
the mouse. Locate  Overtype  in the shortcut menu, and click the left 
mouse button to select the option. Click in the text area to hide the 
shortcut menu. Notice that the Overtype mode indicator appears in the 
status bar.  

   8.   Position the insertion point to the left of “Campbell’s Confections” in the 
second sentence of the first paragraph. Verify that Caps Lock  is still 
active, and key  campbell’s confections .  

   9.   Click the Overtype mode indicator  to turn off Overtype.  

  10.    Press Caps Lock  to turn off Caps Lock mode. Click the 
 File  tab, and click the  Options  command. Click 
 Advanced , locate  Editing options , and verify that the 
 Use overtype mode  is deselected. Click  OK .  

  11.    Right-click the status bar, and deselect  Overtype . Click 
in the text area to close the shortcut menu.     

            Exercise 1-8     COMBINE AND SPLIT 
PARAGRAPHS  

  1.   At the end of the first paragraph, position the insertion point to the left 
of the paragraph mark (after the period following “West Virginia”).  

      2.   Press Delete  once. The two paragraphs are now combined, or merged, 
into one.  

  3.    Press Spacebar  once to insert a space between the sentences.  

  4.    With the insertion point to the left of “For” in the combined paragraph, 
press Enter  once to split the paragraph.    

TIP

Always remember to turn off Overtype 
mode as soon as you are done editing to 

avoid accidentally keying over text.

Figure 1-8
Edited document

Explain how students can also use the 
Backspace key to merge paragraphs.

Word Classroom 
Presentation 1.
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LESSON 1 Creating and Editing a Document WD-13

             Naming and Saving a Document     
      Your document, called “Document1,” is stored in your computer’s temporary 
memory. Until you name and save the document, the data can be lost if you 
have a power failure or a computer hardware problem. It is always good 
practice to save your work frequently. 
    The first step in saving a document for future use is to assign a  file name.   
Study the following rules about naming documents:  

  •   File names can contain up to 260 characters, including the drive letter, 
the folder name, and extension. The following characters cannot be 
used in a file name: 

      / \ > < * ? ” : |   

  •   File names can include uppercase letters, lowercase letters, or a 
combination of both. They can also include spaces. For example, a file 
can be named “Business Plan.”  

  •   Throughout this course, document file names will consist of 
[your initials] (which might be your initials or the identifier your 
instructor asks you to use, such as  rst ), followed by the number of the 
exercise, such as  1-12 . The file name would, therefore, be  rst1-12 .   

    You can use either the Save command or the Save As command to save a 
document. Here are some guidelines about saving documents:  

  •   Use Save As when you name and save a document the first time.  

  •   Use Save As when you save an existing document under a new name. 
Save As creates an entirely new file and leaves the original document 
unchanged.  

  •   Use Save to update an existing document.   

   Before you save a new document, decide where you 
want to save it. Word saves documents in the current drive 
and folder unless you specify otherwise. For example, to 
save a document to a removable storage device, you need to 
change the drive to F:, or whichever is appropriate for your 
computer. 

    Document files are typically stored in folders that are part of a hierarchal 
structure similar to a family tree. At the top of the tree is a disk drive letter 
(such as C:) that represents your computer, network, removable storage de-
vice, or CD/DVD drive. Under the disk drive letter, you can create folders to 
organize your files. These folders can also contain additional folders. 
    For this course, you will create a new folder for each lesson and store 
your completed exercise documents in these folders.        

NOTE

Your instructor will advise you on the 
proper drive and folder to use for this 

course.

 OBJECTIVE 3

Tell students which drive or folder to use to save their 
files. Typically, students save files on a removable 
storage device that they use for all files in the class. 
You might also want to review “File Management” 
on www.mhhe.com/lessonapproach2010.

Emphasize the difference between 
Save and Save As. This concept is 
very important for students new to 
word processing.

Objective 3 Assignment:
Exercise 1-25 (Skills Review) can be 
assigned after completing Objective 3.
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Figure 1-9
Save As dialog box 
using Windows 7

  2.    Locate the  File name  text box. A suggested file name is 
highlighted. Replace this file name by keying  [your 
initials]   1-9 .  

  3.    Drag the scroll box in the Navigation Pane, and choose 
the appropriate drive for your removable storage 
device—Removable Disk (F:), for example.  

NOTE

To save a document as a PDF file, open 
the Save As dialog box, choose the 

appropriate drive and folder for saving 
the document, key the file name, open 
the Save as type drop-down list, and 

choose PDF (*.pdf). Click Save.

Exercise 1-9     NAME AND SAVE A DOCUMENT  

  1.    Click the  File  tab to open the Backstage view, and click  Save As . The 
Save As dialog box appears. The appearance of the Save As dialog box is 
determined by the operating system. The Save As dialog box in Windows 7 
is different from the Save As dialog box shown in Windows XP.        

You might explain file extensions to students. For example, Word 2010 documents have the .docx extension as 
part of the file name. By default, Windows does not display file name extensions. To display them, click the 
Start button, choose Control Panel, click Appearance and Personalization, click Folder Options, click the View 
tab, and then clear the “Hide extensions for known file types” check box.

Throughout the text, students are told to save their files using their initials and the exercise number. If using student initials presents a problem 
(if, for example, students with the same initials save files in a shared folder on a hard drive), assign a unique identifier to each student saving 
files within a particular folder.

Word Classroom 
Presentation 1.
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  4.    Click the New Folder button . A New Folder 
icon appears in the File list section. Key the folder 
name  [your initials]   Lesson1 , and press Enter . The 
folder name appears in the Address bar and in the 
Navigation Pane. Word is ready to save the file in 
the new folder.  

  5.    Click the Save button . Your document is 
named and saved for future use.  

  6.    Open the  File  tab and click  Close . The Close command in Backstage 
view closes the current document but does not exit the Word program. 
If you click the Close button located on the title bar and no other 
documents are open, you exit Word.                           

 Opening an Existing Document  
 Instead of creating a new document for this exercise, you start this exercise 
by opening an existing document. There are several ways to open a 
document: 

  •   Choose Open from the File tab.  

  •   Press Ctrl + O .  

  •    Use the document links in the Recent Documents file listing.     

 The Open command displays the Open dialog box. The commands and 
features listed in the Open dialog box resemble the commands and features 
you studied in the Save As dialog box. Remember the operating system deter-
mines the appearance of the Open dialog box.

Exercise 1-10      OPEN AN EXISTING FILE  

   1.    Click the  File  tab to open the Backstage view. Click the 
 Recent  command. The file names listed under Recent 
Documents are files opened from this computer. If the 
file you want is listed, click its name to open it. The 
Recent Documents section displays up to 22 
documents by default.  

   2.    Click  Open  to display the Open dialog box. You are 
going to open a student file named  Campbell-1 .      

NOTE

When no document is open, the document 
window displays a shaded background. If 
you want to create a new document, click 

the File tab, click New, click Blank document, 
and click Create. The keyboard shortcut to 

start a new document is Ctrl + N .

NOTE

The push pin icon  that appears to the 
right of files listed under Recent 

Documents is used to pin a document to 
the list so that it does not disappear from 
view. Click the pinned icon  to unpin 

the document from the list.

TIP

The keyboard shortcut to open the File 
tab is Alt + F .

The Quick Access Toolbar can 
be customized to include an 
Open button. You may want to 
show students how to add the 
Open button to the Quick 
Access Toolbar.

Important: Make sure students know 
where and how to access files. You may 
also want to discuss the search tools 
available in the Open dialog box as well 
as using the headings to sort files. You 
can protect loaded data files by setting 
the read-only attribute.

This is a good opportunity to discuss the 
benefits of good file management habits. 
Losing track of files is easy, but a sensible 
folder structure can minimize the risk. Open 
Windows Explorer, and demonstrate some 
basic strategies for creating folders and 
subfolders that can make it easier to 
remember where specific files are stored.

 OBJECTIVE 4
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Figure 1-10
Files listed in the 
Open dialog box 
using Windows 7

Navigation Pane

Address bar shows 
current location

TABLE 1-3 Open Dialog Box Buttons

Button Name Purpose

Address bar Navigates to a different folder.

Back button Works with the Address bar, and 
returns to previous location.

Forward 
button

Works with the Address bar, and 
returns to location already opened.

Search box Looks for a file or subfolder.

Organize Opens a menu of file functions, such 
as cutting a file, copying a file, pasting 
a file, deleting a file, or renaming a 
file. Includes the Layout option to 
display the Navigation Pane, Details 
Pane, and the Preview Pane.

New Folder Creates a new folder to organize files.

View Displays a menu of view options for 
displaying drives, folders, files, and 
their icons.

   3.    Locate the appropriate drive and folder according to your instructor’s 
directions.                  

Word Classroom 
Presentation 1.

The student data files are available at the following Web 
site: www.mhhe.com/lessonapproach2010.
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LESSON 1 Creating and Editing a Document WD-17

   4.    After you locate the student files, click the arrow next to the View 
button  in the Open dialog box to display a list of view options.  

   5.   Choose  List  to list the files by file name. 

Figure 1-11
View menu in the 
Open dialog box

TIP

You can also double-click a file name to 
open a file.

NOTE

Documents created in earlier versions of 
Word display Compatibility Mode in the 

Title bar when opened. Compatibility 
Mode enables you to open, edit, and save 
documents that were created using earlier 

versions of Word. New features in 
Microsoft Word 2010 are not available in 

Compatibility Mode. To check for features 
not supported by earlier versions of the 

Word program, click the File tab, and click 
the Info command. Click the Check for 

Issues button. Click Check Compatibility. 
To convert a document created in an 

earlier version of Word to Microsoft Word 
2010, click the Info command, and click 

Convert. Click OK.

Drag slider to change view

    6.     From the list of file names, locate  Campbell-1  and click 
it once to select it.  

   7.    Click  Open .  

Word Classroom 
Presentation 1.

You may want to show students how to open a document created in 
an earlier version of Word and to point out the Compatibility Mode 
notation in the Title bar. Show them how to use the Check 
Compatibility feature.

To open the Preview Pane, click 
the Organize button, click 
Layout, and click Preview Pane.
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   8.    Click the  File  tab, and choose  Save As . You are going to save 
 Campbell-1  under a new file name.  

   9.    Use the  Navigation Pane  to locate the appropriate drive and the folder 
you created for Lesson 1.  

  10.    Verify that the file’s original name ( Campbell-1 ) is selected. If it is not 
selected, double-click it.  

  11.   Key the file name  [  your initials]  1-10 , and click  Save .                      

Exercise 1-11 ENTER FORMATTING CHARACTERS 

 The Show/Hide ¶ button on the Home tab displays or hides paragraph 
marks and other  formatting marks.  These characters appear on the screen, 
but not in the printed document. Formatting marks are included as 
part of words, sentences, and paragraphs in a document. Here are some 
examples: 

  •   A word includes the space character that follows it.  

  •   A sentence includes the end-of-sentence punctuation and at least one 
space.  

  •   A paragraph is any amount of text followed by a paragraph mark.       

     The document you opened contains two additional formatting charac-
ters:  tab characters,  which you use to indent text, and  line-break characters,
which you use to start a new line within the same paragraph. Line-break 
characters are useful when you want to create a paragraph of short lines, 
such as an address, and keep the lines together as a single paragraph. 
  Another formatting character is a  nonbreaking space,  which you use to 
prevent two words from being divided between two lines. For example, you 
can insert a nonbreaking space between “Mr.” and “Smith” to keep the name 
“Mr. Smith” undivided on one line.        
TABLE 1-4 Formatting Characters

Character To Insert, Press

Tab (→) Tab

Space (·) Spacebar

Nonbreaking space (°) Ctrl + Shift + Spacebar

Paragraph mark (¶) Enter

Line-break character (↵) Shift + Enter

Documents created in earlier versions 
of Word can be converted to Microsoft 
Word 2010. Click the File tab, and click 
the Info command. Click Convert. Click 
OK in the Microsoft Word dialog box. 
Save the document.

The Show/Hide ¶ button may not show or hide all 
formatting marks. You can choose to display all or 
selected formatting marks at all times. To turn on 
or turn off the display of formatting marks, click 
the File tab and click Options. Click Display to 
select an option to display at all times. Click OK.

Point out the tab characters 
in this document, and briefly 
explain their use.
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  1.   Click the Show/Hide ¶ button  if the formatting characters in the 
document are hidden.  

  2.   Move the insertion point to the end of the document (after “family 
recipes.”).  

  3.   Press Enter  to begin a new paragraph, and key  Campbell’s Confections 
has been a member in good standing of the NCA for over 50  (do not 
press Spacebar ).  

  4.   Insert a nonbreaking space after “50” by pressing Ctrl + Shift + Spacebar . 
Then key  years.  (including the period). Word now treats “50 years” as a 
single unit.                  

Figure 1-12
Formatting 
characters

Line-break characterTab character

Paragraph mark

Nonbreaking space

Space character

      5.   Press Enter  and key the following text as one paragraph at the end of the 
document, pressing Shift + Enter  at the end of the first and second lines 
instead of Enter . 

     Campbell’s Confections  
     25 Main Street  
     Grove City, PA 16127   

  6.   Click the Show/Hide ¶ button  to hide the formatting characters, and 
click it again to redisplay them.        

Word Classroom 
Presentation 1.

Line-break characters might be confusing at this point. After students learn how to select text, have them 
practice selecting the paragraphs that contain line breaks. Manual line breaks are often used when a 
paragraph style has extra space before the paragraph and you don’t want short lines of text to include that 
extra space.
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 Moving within a Document  
 You already know how to move around a short document by positioning the 
I-beam pointer with the mouse and clicking. This is the easiest way to move 
around a document that displays in the document window. If a document is 
too long or too wide to view in the window, you need to use different meth-
ods to navigate within a document. 
    Word offers two additional methods for moving within a document: 

  •    Using the keyboard:  You can press certain keys on the keyboard to move 
the insertion point. The arrow keys, for example, move the insertion 
point up or down one line or to the left or right one character. Key 
combinations quickly move the insertion point to specified locations in 
the document.  

  •      Using the scroll bars:  Use the vertical scroll bar at the 
right edge of the document window to move through 
a document. The position of the scroll box indicates 
your approximate location in the document, which is 
particularly helpful in long documents. To view and 
move through a document that is wider than the 
document window, use the horizontal scroll bar at the 
bottom of the document window.     

Exercise 1-12 USE THE KEYBOARD TO 
MOVE THE INSERTION 
POINT 

      1.    Press Ctrl + Home  to move to the beginning of the 
document. Press End  to move to the end of the first 
line.  

  2.    Press Ctrl +  several times to move the insertion 
point down one paragraph at a time. Notice how the 
text with the line-break characters is treated as a 
single paragraph.  

NOTE

Scrolling through a document does not 
move the insertion point. It moves only 
the portion of the document you are 

viewing in the document window. When 
you use the keyboard to move within a 
document, the insertion point always 

moves to the new location.

TIP

Word remembers the last three locations 
in the document where you edited or 

keyed text. You can press Shift + F5  to 
return the insertion point to these 

locations. For example, when you open a 
document you worked on earlier, press 
Shift + F5  to return to the place where 

you were last working before you saved 
and closed the document.

 OBJECTIVE 5

Demonstrate that scrolling through a document does not move 
the insertion point. This can be difficult for students to 
understand. They often scroll through a document and then 
attempt to enter text in the visible portion of the document 
although the insertion point has not moved.

Remind students that using the keyboard can be faster than using 
the mouse when moving through a document because you do not 
have to take your hands away from the keyboard to do it.
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TABLE 1-5 Keys to Move the Insertion Point

To Move Press

One word to the left Ctrl +

One word to the right Ctrl +

Beginning of the line Home

End of the line End

One paragraph up Ctrl +

One paragraph down Ctrl +

Previous page Ctrl + PageUp

Next page Ctrl + PageDown

Up one window PageUp

Down one window PageDown

Top of the window Alt + Ctrl + PageUp

Bottom of the window Alt + Ctrl + PageDown

Beginning of the document Ctrl + Home

End of the document Ctrl + End

 Exercise 1-13  SCROLL THROUGH 
A DOCUMENT 

 Using the mouse and the scroll bars, you can scroll up, 
down, left, and right. You can also set the Previous and Next 
buttons on the vertical scroll bar to scroll through a 
document by a specific object, such as tables or headings. 

For example, use these buttons to jump from one heading to 
the next, going forward or backward. 

  3.    When you reach the end of the document, press Page Up  until you return 
to the beginning of the document.         

NOTE

The horizontal scroll bar does not display 
if the document window is wide enough 
to display the document text. To display 

the horizontal bar, resize the window.

Table 1-5 is especially helpful for anyone who has keyboarding skills. Suggest 
that students practice these skills.
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         2.    Drag the scroll box to the top of the scroll bar.  

  3.    Click the down scroll arrow  on the scroll bar three 
times. The document moves three lines.  

  4.    Click the up scroll arrow  on the vertical scroll 
bar three times to bring the document back into 
full view. 

     Notice that as you scroll through the document, the 
insertion point remains at the top of the document.  

  5.    Click the Select Browse Object button  , located 
toward the bottom of the vertical scroll bar. A palette of 
icons appears.  

  6.    Move the pointer over each icon to identify it. These 
browse options become significant as your documents 
become more complex. Click the Browse by Page 
icon .                                  

Figure 1-13
Using the scroll bars

Left scroll arrow Scroll box Right scroll arrow

Next

Previous

Down scroll arrow

Scroll box

Up scroll arrow

Vertical scroll bar

Horizontal scroll bar

Select Browse Object

TIP

The keyboard shortcut to display 
the Select Browse Object menu is 

Ctrl + Alt + Home .

TIP

If you are using a mouse with a wheel, 
additional navigating options are available. 

For example, you can roll the wheel 
forward or backward instead of using the 
vertical scroll bars, hold down the wheel 

and drag in any direction to pan the 
document, or hold down Ctrl  as you roll 
the wheel to change the magnification.

  1.    Locate the vertical scroll bar, and click below the scroll box to move 
down one window. 

Word Classroom 
Presentation 1.

It may be necessary to resize the document 
window to display the horizontal scroll bar.

Efficient scrolling is a necessary word processing skill. 
Have students practice scrolling through a document, 
using all the methods discussed in Table 1-6.
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TABLE 1-7 Mouse Selection

To Use the Mouse to Select

A series of characters Click and drag, or click one end of the text block, and then hold down Shift  
and click the other end.

A word Double-click the word.

A sentence Press Ctrl  and click anywhere in the sentence.

A line of text Move the pointer to the left of the line until it changes to a right-pointing 
arrow, and then click. To select multiple lines, drag up or down.

A paragraph Move the pointer to the left of the paragraph and double-click. To select multiple 
paragraphs, drag up or down. You can also triple-click a paragraph to select it.

The entire document Move the pointer to the left of any document text until it changes to a 
right-pointing arrow, and then triple-click (or hold down Ctrl  and click).

TABLE 1-6 Scrolling through a Document

To Move Do This

Up one line Click the up scroll arrow .

Down one line Click the down scroll arrow .

Up one window Click the scroll bar above the scroll box.

Down one window Click the scroll bar below the scroll box.

To any relative position Drag the scroll box up or down.

To the right Click the right scroll arrow .

To the left Click the left scroll arrow .

Into the left margin Hold down Shift  and click the left scroll arrow .

Up or down one page Click Select Browse Object , click Browse by Page , and then click 
Next  or Previous .

     Selecting Text  
Selecting text  is a basic technique that makes revising documents easy. When 
you select text, that area of the document is called the  selection,  and it ap-
pears as a highlighted block of text. A selection can be a character, group of 
characters, word, sentence, or paragraph or the whole document. In this les-
son, you delete and replace selected text. Future lessons show you how to 
format, move, copy, delete, and print selected text. 
    You can select text several ways, depending on the size of the area you 
want to select.            

Demonstrate selecting text with the mouse. 
Tell students a “selection” is also commonly 
called a “block.” Make sure students know 
how to cancel a selection.

The Select Browse Object button is more meaningful when the document is long or 
contains headings, graphics, tables, fields, or sections. Tell students the Browse 
Object menu also contains an icon to browse by edits. When you choose this option, 
the Previous and Next buttons become the Previous Edit and Next Edit buttons.

 OBJECTIVE 6
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 Exercise 1-14  SELECT TEXT WITH THE MOUSE  

  1.    Select the first word of the document by double-clicking it. Notice that the 
space following the word is also selected. When text is selected, a Mini 
toolbar appears with formatting options.        

Figure 1-14
Selecting a word

  2.   Cancel the selection by clicking anywhere in the document. Selected 
text remains highlighted until you cancel the selection.  

  3.   Select the first sentence by holding down Ctrl  and clicking anywhere 
within the sentence. Notice that the period and space following the 
sentence are part of the selection. Cancel the selection.  

  4.   Locate the paragraph that begins “Visit one of our.”  

  5.    To select the text “milk chocolate,” click to the left of 
“milk.” Hold down the left mouse button and slowly 
drag through the text, including the comma and space 
after “chocolate.” Release the mouse button. Cancel 
the selection.      

  6.    To select the entire paragraph by dragging the mouse, 
click to position the insertion point to the left of 
“Visit.” Hold down the mouse button, and then drag 
across and down until all the text and the paragraph 
mark are selected. Cancel the selection.  

      7.    Select the same paragraph by moving the pointer into 
the blank area to the left of the text “Visit.” (This is the 
margin area.) When the I-beam pointer changes to a 
right-pointing arrow , double-click. Notice that the 
fi rst click selects the first line and the second click 
selects the paragraph, including the paragraph mark. 
Cancel the selection.                

TIP

When selecting more than one word, you 
can click anywhere within the first word 
and then drag to select additional text. 

Word “smart-selects” the entire first 
word.

TIP

You can also triple-click within a 
paragraph to select it.

Word Classroom 
Presentation 1.

Have students test Word’s “smart 
select” capability by dragging from 
midword to select two consecutive 
words.

Students might need to practice moving the pointer in the margin 
area to display the right-pointing arrow. If the pointer does not point 
to the right, text cannot be selected as described. Have the students 
move the pointer around and observe how it changes shape.

Remind students that the position of the pointer determines 
which line is selected. To select the first line, the pointer must be 
to the left of the first line.

Remind students that when text is selected using the margin area, 
the selection must be canceled within the text area, not in the 
margin area.
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Exercise 1-15       SELECT NONCONTIGUOUS TEXT 

 In the previous exercise, you learned how to select  contiguous text,  where the 
selected characters, words, sentences, or paragraphs follow one another. But 
sometimes you would like to select  noncontiguous text,  such as the first and 
last items in a list or the third and fifth word in a paragraph. In Word, you 
can select noncontiguous text by using Ctrl  and the mouse.  

  1.   Select the first line of the list (“retail”).  

  2.   Press Ctrl  and select the third line of the list (“fundraising”). With these 
two separate lines selected, you can delete, format, or move them 
without affecting the rest of the list.  

  3.   Cancel the selection, and go to the paragraph that begins “Visit one 
of our.”  

      4.   In the paragraph that begins “Visit one of our,” double-click the word 
“our” before “Web site.” With the word now selected, hold down Ctrl  as 
you double-click the word “selections” in the same sentence and 
“finest” in the next sentence. (See  Figure 1-16 .) All three words are 
highlighted.     

Figure 1-15
Selecting text

Word Classroom 
Presentation 1.

Students might have trouble understanding the usefulness of 
selecting noncontiguous text. Using step 4 as an example, tell 
students this selection method would be handy if the user 
wanted to italicize all three words. Now they can all be made 
italic in one step.
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  5.   Cancel the selection.     

 Exercise 1-16  ADJUST A SELECTION USING 
THE MOUSE AND THE KEYBOARD  

  1.   Select the paragraph beginning “Visit one of our.”  

  2.   Hold down Shift  and press  until the last sentence is 
no longer highlighted. Release Shift .  

  3.   Increase the selection to include the last sentence by 
holding down Shift  and pressing End  and then 
pressing . Release Shift .  

  4.   Increase the selection to include all the text below it by 
holding down Shift  and clicking at the end of the 
document (after the ZIP Code).  

  5.   Select the entire document by pressing Ctrl + A . Cancel 
the selection.                 

Figure 1-16
Selecting 

noncontiguous 
words

NOTE

Another way to extend a text selection is 
to turn on Selection mode by pressing 

F8 . In Selection mode, you can press F8  
to select a word, press it again to select a 

sentence, press it again to select a 
paragraph, and press it again to select the 

entire document. Press Shift + F8  to 
shorten the selection. Press Esc  to turn 
off Selection mode. Right-click the status 
bar, and click Selection Mode to turn on 

or turn off the status bar indicator.

Word Classroom 
Presentation 1.

Demonstrate how using the mouse for selecting is not always the 
most effective approach and that sometimes the mouse selection 
must be adjusted using the keyboard. You can demonstrate the 
difficulty of selecting single characters or multiple paragraphs 
that extend beyond the portion of the document appearing on the 
screen.

hin19294_ch01_WD001-WD047.indd Page WD-26  09/04/10  7:36 PM user-f467hin19294_ch01_WD001-WD047.indd Page WD-26  09/04/10  7:36 PM user-f467 /Volumes/203/MHRL033/ros69760_disk1of1/0070969760/ros69760_pagefiles/Volumes/203/MHRL033/ros69760_disk1of1/0070969760/ros69760_pagefile
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     Exercise 1-17 EDIT TEXT BY REPLACING A SELECTION 

 You can edit a document by selecting text and deleting or replacing the 
selection.  

  1.    Locate the paragraph that begins “Visit one of our,” 
and select the word “our” in the first sentence that 
follows the word “about.”  

  2.   Key  the variety of  to replace the selected text.  

  3.    Locate the paragraph that begins “Campbell’s 
Confections has been,” and select “NCA.” Key 
National Confectioners Association . Notice that, 
unlike using Overtype mode, when you key over 
selected text, the new text can be longer or shorter 
than the selection.     

Exercise 1-18    UNDO AND REDO ACTIONS 

 Word remembers the changes you make in a document and lets you undo or 
redo these changes. For example, if you accidentally delete text, you can use 
the Undo command to reverse the action and restore the text. If you change 
your mind and decide to keep the deletion, you can use the Redo command 
to reverse the canceled action. 

TABLE 1-8 Keyboard Selection

To Select Press

One character to the right Shift +

One character to the left Shift +

One word to the right Ctrl + Shift +

One word to the left Ctrl + Shift +

To the end of a line Shift + End

To the beginning of a line Shift + Home

One line up Shift +

One line down Shift +

One window down Shift + PageDown

One window up Shift + PageUp

To the end of a document Ctrl + Shift + End

To the beginning of a document Ctrl + Shift + Home

An entire document Ctrl + A

NOTE

Although keying over selected text is an 
excellent editing feature, it sometimes 

leads to accidental deletions. Remember, 
when text is selected in a document (or 

even in a dialog box) and you begin 
keying text, Word deletes all the selected 
text with your first keystroke. If you key 
text without realizing a portion of the 
document is selected, use the Undo 

command to restore the text.
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 There are two ways to undo or redo an action: 

  •    Click the Undo button  or the Redo button  on the 
Quick Access Toolbar.  

  •    Press Ctrl + Z  to undo or Ctrl + Y  
to redo.      

    1.   Delete the first word in the document, “Campbell’s,” by moving the 
insertion point to the right of the space after the word and pressing 
Ctrl + Backspace . (Remember that a word includes the space that follows it.)  

      2.   Click the Undo button  to restore the word.  

  3.   Move the insertion point to the left of the word “candy” in the first line 
of the first paragraph.  

  4.   Key  midsize  and press Spacebar  once. The text now reads “midsize candy 
manufacturer.”  

  5.   Press Ctrl + Z . The word “midsize” is deleted.  

  6.   Click the Redo button  to restore the word “mid-size.”  

  7.   Click the down arrow to the right of the Undo button . Word displays 
a drop-down list of the last few actions, with the most recent action at 
the top. You can use this feature to choose several actions to undo 
rather than just the last action. Click  Cancel  to close the list.  

  8.   Click the Undo button .   

NOTE

The Redo button is also identified as the 
Repeat button. Use the Repeat command 

to repeat the last action performed.

Figure 1-17
Undo drop-down list

          Exercise 1-19 REPEAT ACTIONS 

 Suppose you key text you want to add to other areas of a document. Instead of 
rekeying the same text, you can use the Repeat command to duplicate the text. 
  To use the Repeat command, press either: 

  •   Ctrl + Y   

  •   F4      

  1.    In the first paragraph position the insertion point to 
the left of the word “candy.”  

  2.    Key  popular  and press Spacebar  once. The sentence now 
begins “Campbell’s Confections is a popular candy.”  

NOTE

If you want to undo, redo, or repeat your 
last action, do so before you press 

another key.

Make sure students feel comfortable using the Undo button. Stress that it 
should be clicked immediately after an action they want to undo. Being 
able to undo a mistake often relieves anxiety for students who are new to 
word processing.

Word Classroom 
Presentation 1.
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  3.    Move the insertion point to the left of the word “selections” in the 
paragraph that begins “Visit one of our.”  

      4.   Press F4  and the word “popular” is repeated.               

 Printing a Document     
      After you create a document, printing it is easy. You can use any of the fol-
lowing methods: 

  •   Choose Print from the File tab.  

  •   Press Ctrl + P .    

    The Print command in Backstage view and the keyboard shortcut to 
print display the Print tab, where you can select printing options and preview 
the document. Clicking the Print button  sends the document directly to 
the printer, using Word’s default settings.  

         Exercise 1-20 PRINT A DOCUMENT    

      1.   Click the  File  tab to open the Backstage view. Click the  Print  command. 
The Print tab displays Word’s default print settings and a preview of the 
document.     

Figure 1-18
Print tab

     2.   Click the Print button  to accept the default print settings.               

 OBJECTIVE 7

Explain that the Repeat command only repeats the 
last command or action issued. It does not repeat 
multiple commands or actions.

Word Classroom 
Presentation 1.

Make sure the correct printer is selected before students initiate the Print command. You might have students key their name or initials on every 
printed document. This prevents unknown papers from being printed—especially if students share printers.

Objective 7 Assignment:
Exercise 1-26 (Skills Review) can be assigned 
after completing Objective 7.
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 Closing a Document and Exiting Word           
 Exercise 1-21  SAVE A REVISED 

DOCUMENT 

 You have already used the Save As command to rename the 
document you opened earlier in this lesson. Now that you 
have made additional revisions, you can save a final version 

of the document by using the Save command. The document is saved with all 
the changes, replacing the old file with the revised file.    

  1.   Click the Save button  on the Quick Access Toolbar. This action saves 
the changes to the document. Since the document was saved earlier in 
the lesson, the Save As dialog box does not display.     

 Exercise 1-22  CHECK WORD’S AUTORECOVER 
SETTINGS 

 Word’s  AutoRecover  feature can automatically save open documents at an 
interval you specify. However, this is not the same as saving a file yourself, as 
you did in the preceding exercise. AutoRecover’s purpose is to save open 
documents “in the background,” so a recently saved version is always on disk. 
Then if the power fails or your system crashes, the AutoRecover version of 
the document opens automatically the next time you launch Word. In other 
words, AutoRecover ensures you always have a recently saved version of your 
document. 
  Even with AutoRecover working, you need to manually save a document 
(by using the Save command) before closing it. AutoRecover documents are 
not always available. If you save and close your file normally, the AutoRecover 
version is deleted when you exit Word. Still, it is a good idea to make sure 
AutoRecover is working on your system and to set it to save recovery files 
frequently.  

  1.   Open the  File  tab, and click  Options  to open the Word Options 
dialog box.  

  2.   Click the  Save  command in the left pane.  

  3.   Make sure the  Save AutoRecover information every  box is checked. 
If it is not checked, click the box.  

  4.   Click the up or down arrow buttons to set the  minutes  to 5. 
Click  OK .      

NOTE

If you wanted to save the current 
document with a different file name, you 

would use the Save As command.

 OBJECTIVE 8

You may want to demonstrate AutoRecover if 
this feature is not available to students.

Objective 8 Assignment:
Exercises 1-27 and 1-28 (Skills Review), 
Exercises 1-29 through 1-32 (Lesson 
Applications), and 1-33 through 1-35 (On Your 
Own) can be assigned after completing 
Objective 8.
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       Exercise 1-23  REVIEW AND EDIT DOCUMENT 
PROPERTIES    

    Information that describes your document is called a  property.  Word 
automatically saves your document with certain properties, such as the file 
name, the date created, and the file size. You can add other properties to a 
document, such as the title, subject, author’s name, and keywords. This 
information can help you organize and identify documents.    

  1.   With the file  [your initials]  1-10  still open, click the 
 File  tab and click the  Info  command. Locate the 
Properties button  under the document 
preview. Click the down arrow, and click  Advanced 
Properties . The Document Properties dialog box 
displays.     

Figure 1-19
Setting AutoRecover 

options

NOTE

You can also search for documents based 
on document properties by using the 

Search feature.

Click to select

Word Classroom 
Presentation 1.

Show students how to print document 
properties by opening the Print tab and 
choosing Document Properties from the Print 
drop-down list.
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Figure 1-20
Entering Summary 

information

     2.   Click the  General  tab. This tab displays basic information about the file, 
such as file name, file type, location, size, and creation date.  

  3.   Click the  Statistics  tab. This tab shows the exact breakdown of the 
document in number of paragraphs, lines, words, and characters.  

      4.   Click the  Summary  tab. Here you can enter specific document property 
information or change existing information.  

  5.   Key or edit the title to read  Campbell’s Confections , and key  [your 
name]  as the author. Click  OK .  

      6.   Save the document, and submit your work.  

Word Classroom 
Presentation 1.

When students display the Summary tab, 
information might already be entered in the 
Author or Company text boxes, depending on 
how Word was installed on their computers. 
For example, the school name might appear in 
the Company text box.

You can also view document properties in the 
Open dialog box or the Save As dialog box by 
clicking the Organize drop-down arrow.

Show students how to print document 
properties by opening the Print tab, 
and choosing Document properties 
from the Print All Pages drop-down list.

From this point forward in the textbook, students 
will be instructed to “Submit your work.” Inform 
students on your procedures for submitting 
work: printed document, e-mail document, or 
drop box.
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Exercise 1-24  CLOSE A DOCUMENT 
AND EXIT WORD 

 When you finish working on a document and save it, you can close it and 
open another document, or you can exit Word. 
  The easiest ways to close a document and exit Word include using the 
following: 

  •   The Close button in the upper right corner of the Word window.  

  •   The Close command from the File tab.  

  •   Keyboard shortcuts:    

  Ctrl +W  closes a document. 

  Alt + F4  exits Word.  

  1.    Click the  File   tab, and choose  Close  from the 
Backstage view Navigation Pane.  

  2.    Click the Close button  in the upper right corner 
of the screen to exit Word and to display the Windows 
desktop.      

NOTE

When no document is open, the 
document window is gray. If you want to 

create a new document, choose New 
from the File tab, click Blank Document, 

and click the Create button. The keyboard 
shortcut to create a new document is 

Ctrl + N .

 Using Online Help    
    Online Help is available to you as you work in Word. Click the Help 
button  or press F1  to open the Word Help window. You can click a 
Word Help link or key a word or phrase in the Search box. 

 FIND OUT MORE ABOUT USING HELP 

  1.   Start Word.  

  2.   Locate the Help button  in the upper right corner of the screen. Click 
the button to open the Word Help window.  

  3.   Locate and click the link  Getting started with Word 2010 .      

LESSON 1 Creating and Editing a Document

Encourage students to follow the steps in 
“Using Online Help” (with a blank document 
open).
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Figure 1-21
Using the Word 
Help window

      4.   Review the list of topics.  

  5.   Click the topic “What’s new in Microsoft Word,” and review the 
information.  

  6.   Click the Back button  to return to the list of categories.  

  7.   Close Help by clicking the Word Help window’s Close button .

Word Classroom 
Presentation 1.
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            Lesson 1   Summary    

     •   To start Microsoft Word, click the Start button on the Windows taskbar, 
point to All Programs, click Microsoft Office, and click Microsoft Word 2010.  

  •   The File tab is located to the left of the Home tab on the Ribbon. Click 
the tab to open the Backstage view.  

  •   The title bar is at the top of the Word screen and displays the current 
document name.  

  •   The Quick Access Toolbar displays icons for Save, Undo, and Repeat.  

  •   The Ribbon contains tabs which include groups of related commands. 
Commands can be buttons, menus, or drop-down list boxes.  

  •   Click a tab name to display related groups of commands. The number of 
groups and commands varies for each tab.  

  •   Identify a command by name by pointing to it with the mouse. Word 
displays a ScreenTip with the command name.  

  •   The horizontal ruler appears below the Ribbon.  

  •   Scroll bars appear as shaded bars to the right and bottom of the text 
area. They are used to view different portions of a document.  

  •   The status bar is located at the bottom of the Word screen. It displays 
the page number and page count of the document, the document view 
buttons, and the zoom control. It also displays the current mode of 
operation. Right-click the status bar to customize it.  

  •   Use the Zoom feature to change the magnification of the text area.  

  •   The blinking vertical line in the text area is called the insertion point. It 
marks the position of the next character to be keyed.  

  •   The mouse pointer displays as an I-beam when it is in the text area and 
as an arrow when you point to a command outside the text area.  

  •   When the Show/Hide ¶ button is turned on, a paragraph mark symbol 
appears at the end of every paragraph. A dot between words represents 
a space.  

  •   Word automatically wraps text to the next line as you key text. Press 
Enter  to start a new paragraph or to insert a blank line.  

  •   Word flags spelling errors as you key text by inserting a red, wavy line 
under the misspelled word. To correct the spelling, point to the underlined 
word, click the right mouse button, and choose the correct spelling.  

  •   Word automatically corrects commonly misspelled words for you as you 
key text. Word can automatically complete a word for you, such as the 
name of a month or day. Word suggests the completed word, and you 
press Enter  to insert it.  

  •   Delete a single character by using Backspace  or Delete . Ctrl + Backspace  
deletes the word to the left of the insertion point. Ctrl + Delete  deletes the 
word to the right of the insertion point.  

  •   To insert text, click to position the insertion point, and key the text.  

  •   To key text over existing text, turn on Overtype mode.  

WD-35LESSON 1 Creating and Editing a Document

Encourage students to use the Lesson Summary to review the 
important concepts in the lesson.
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  •   Insert one space between words and between sentences.  

  •   Document names, or file names, can contain 260 characters, including the 
drive letter, folder name, and extensions. The file name can contain spaces. 
The following characters cannot be used in a file name:  / \ > < * ? “ : |   

  •   Save a new document by using the Save As command and giving the 
document a file name. Use the Save command to update an existing 
document.  

  •   Create folders to organize your files. You can do this in the Save As 
dialog box, using the New Folder button. Rename folders by locating 
and selecting the folder. Right-click the folder name, and choose 
Rename from the shortcut menu  

  •   To start a new blank document, press Ctrl + N , or click the File tab. Click 
New, click Blank document, and click Create.  

  •   Use the Open dialog box to open an existing file. Use the Views button in 
the dialog box to change the way files are listed.  

  •   Formatting characters—such as blank spaces or paragraph marks—appear 
on-screen, but not in the printed document. Insert a line-break character 
to start a new line within the same paragraph. Insert a nonbreaking space 
between two words to make sure they appear on the same line.  

  •   When a document is larger than the document window, use the 
keyboard or the scroll bars to view different parts of the document. 
Keyboard methods for moving within a document also move the 
insertion point.  

  •   Keyboard techniques for moving within a document include single keys 
(such as Page Up  and Home ) and keyboard combinations (such as Ctrl + ). 
See Table 1-5.  

  •   Scrolling techniques for moving within a document include clicking the 
up or down scroll arrows on the vertical scroll bar or dragging the scroll 
box. Scrolling does not move the insertion point. See Table 1-6.  

  •   Selecting text is a basic technique for revising documents. A selection is 
a highlighted block of text you can format, move, copy, delete, or print.  

  •   There are many different techniques for selecting text, using the mouse, 
the keyboard, or a combination of both. Mouse techniques involve 
dragging or clicking. See Table 1-7. Keyboard techniques are listed in 
Table 1-8.  

  •   You can select any amount of contiguous text (characters, words, 
sentences, or paragraphs that follow one another) or noncontiguous text 
(such as words that appear in different parts of a document). Use Ctrl  
along with the mouse to select noncontiguous blocks of text.  

  •   When text is selected, Word replaces it with any new text you key, or it 
deletes the selection if you press Delete .  

  •   If you make a change in a document that you want to reverse, use the 
Undo command. Use the Redo command to reverse the results of an 
Undo command.  

  •   If you perform an action, such as keying text in a document, and you 
want to repeat that action elsewhere in the document, use the Repeat 
command.  

  •   Choose Print from the File tab, or press Ctrl + P  to print a document.  

WD-36 UNIT 1 Basic Skills
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  •   Use the Save command to save any revisions you make to a document.  

  •   Word’s AutoRecover feature periodically saves open documents in the 
background so you can recover a file in the event of a power failure or 
system crash.  

  •    Document properties are details about a file that help 
identify it. Properties include the file name, file size, and 
date created, which Word updates automatically. Other 
properties you can add or change include title, subject, 
author’s name, and keywords. View or add properties 
for an open document by clicking the File tab and 
clicking Info.  

  •   To use Word Help, click the Help button or press F1 .    

LESSON                 Command Summary

Feature Button Command Keyboard

Close a document File tab, Close Ctrl +W  or Ctrl + F4

Document Properties File tab, Info command

Exit Word File tab, Exit Alt + F4

Help F1

Open File tab, Open Ctrl + O  or Ctrl + F12

Print File tab, Print Ctrl + P

Redo Quick Access Toolbar Ctrl + Y  or
 Alt + Shift + Backspace

Repeat Quick Access Toolbar Ctrl + Y  or F4

Save Quick Access Toolbar Ctrl + S  or Shift + F12

Save As File tab, Save As F12

Select entire document Home tab, Editing group, 
Select All

Ctrl + A

Undo Quick Access Toolbar Ctrl + Z  or Alt + Backspace

NOTE

Word provides many ways to accomplish 
a particular task. As you become more 

familiar with Word, you will find the 
methods you prefer.

WD-37LESSON 1 Creating and Editing a Document

Point out that the Command Summary lists a variety of ways to 
accomplish a specific task. Students can decide which method they 
prefer to use.
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 True/False Questions 
 Each of the following statements is either true or false. Indicate your 
choice by circling T or F. 

1. A line-break character is used to begin a new paragraph.

2. The Overtype mode indicator appears on the status bar by default.

3. You can view more than one Ribbon tab at a time.

4. To select a sentence, you can double-click anywhere within the sentence.

5. Noncontiguous text is text that does not appear consecutively in a Word 
document.

6. Pressing Delete  deletes characters to the left of the insertion point.

7. Ctrl + Delete  deletes the word to the right of the insertion point.

8. You can save a document by choosing Save from the File tab.  

 Short Answer Questions 
 Write the correct answer in the space provided. 

  1.   What is the keyboard shortcut to print a document?  

Ctrl + P  

  2.   Which formatting character would you insert between two words to 
keep them together in a sentence?  

  Nonbreaking space 

  3.   If you begin keying a word such as “January” or “Thursday,” how can 
you have Word complete the word for you automatically?  

  Press Enter  when the ScreenTip appears. 

  4.   Which area of the Word screen shows the number of pages in the 
document and displays indicators that show the current mode of 
operation?  

  Status bar 

  5.   What is the keyboard shortcut to move the insertion point to the 
beginning of a document?  

Ctrl + Home  

           Concepts Review  

UNIT 1 Basic SkillsWD-38

T F 

T F 

T F 

T F 

T F 

T F 

T F 

T F 

CLOSE
Concepts Review:
Allows students to check their understanding.

TEST BANK
Consider using the Test Bank to provide an 
additional review of lesson concepts. It may 
also be used as an assessment tool.

CLOSE

TEST BANK
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  6.   What is the shape of the mouse pointer when it appears in the text area 
of the screen?  

  I-beam 

  7.   Which command is used to save a document under a different file name?

  Save As command   

  8.   What is the keyboard shortcut for Help?    

  F1  

         Critical Thinking    
 Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.  

  1.   You can use the Show/Hide ¶ button to hide paragraph marks and 
space characters. When might it be useful to show these characters? 
When would you want to hide them?  

  2.   Word allows great flexibility when naming files. Many businesses and 
individuals establish their own rules for naming files. What kinds of 
rules would you recommend for naming files in a business? For 
personal use?      

 Skills Review 
        Exercise 1-25 
 Key, edit, and save a document.      

       1.   Press Ctrl + N  to create a new document.  

  2.   Key the text shown in  Figure 1-22 . (Use default formatting.)  

Figure 1-22 Campbell’s Confections recently celebrated another 
anniversary in the candy business. The company manufactures 
over 600 candy creations and produces over 1 million pounds 
of chocolate each year. Caramel Pecanettes and Cordial 
Cherries are the most popular candy creations. Campbell’s 
Confections has been at its current location for all of its 
57 years.

LESSON 1 Creating and Editing a Document

Skills Review:
Provides guided practice for students. 
Objectives are indicated for each exercise.

Exercise 1-25:
Objectives: 1–3
Required Files: None
Solution File: 1-25 on the Online Learning Center.

Students may accidentally exit Word when they close a 
document. Encourage them to start Word and continue with 
the exercises.

The keyboard shortcut to create a new document is
 Ctrl + N . This method is quicker than opening 
the File tab.

Critical Thinking:
Answers will vary based on 
students’ preferences, 
observations, experiences, and 
research.
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  3.   Correct any spelling mistakes Word locates.  

  4.   Delete the text “all of its” in the last sentence by following these steps:    

a.  Move the insertion point to the right of the word “for” by positioning 
the I-beam and clicking the left mouse button.    

b.  Hold down Ctrl  and press Delete  three times to delete the words “all 
of its.”    

  5.   Insert text after the word “Pecanettes” in the third sentence by following 
these steps:    

a.  Move the insertion point to the immediate right of the word 
“Pecanettes,” and key a comma and a space.

b.     Key  Melt-a-ways  followed by a comma.    

  6.   Split the paragraph by following these steps:    

a.  Move the insertion point to the immediate left of the word 
“Campbell’s” in the last sentence.

b.     Press Enter .    

  7.   Select the first word of the second sentence in the first paragraph “The,” 
and key  Our . Locate the phrase “the most popular” in the last sentence 
of the first paragraph, and change “the” to  our .  

        8.   Save the document as  [your initials]  1-25  in your Lesson 1 folder.  

  9.   Close the document.      

 Exercise 1-26 
 Key, edit, save, and print a document.       

   1.   Start a new blank document by pressing Ctrl + N .  

   2.   Key the text shown in  Figure 1-23 . Correct spelling mistakes as you key. 
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Figure 1-23 When you visit our inaugural store, take advantage of our 
factory tour where you can see each of the steps in candy 
making. You will follow the chocolate manufacturing line 
beginning with melting the chocolate, preparing the rich 
cream centers, and dipping the candy with two coats of 
chocolate. All of our chocolates are hand decorated and 
carefully packaged.

      3.   Move the insertion point to the left of the word “inaugural” in the first 
line of the paragraph.  

   4.   Open the  File  tab. Click  Options , and click  Advanced  in the left pane. 
Under Editing options, click  Use overtype mode  to turn on Overtype 
mode. Click  OK .  

When the Save As dialog box is first opened, the text in 
the File name text box is selected. If a student clicks 
within the dialog box, such as to change the drive, you 
might want to explain how to select the existing file 
name text by dragging with the mouse.

Exercise 1-26:
Objectives: 2–3, 5–8
Required Files: None
Solution File: 1-26 on the Online 
Learning Center.
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   5.   Key  flagship  over the word “inaugural.” Be sure to delete the extra 
character.  

   6.   Turn off Overtype mode by clicking the  File  tab and clicking  Options . 
Click  Advanced  in the left pane, and click  Use overtype mode  to turn off 
Overtype mode. Click  OK .  

   7.   Double-click to select the word “manufacturing” and key  production  to 
replace it.  

   8.   Check the spacing before and after the replacement text.  

   9.   Save the document as  [your initials]  1-26  in your Lesson 1 folder.  

   10.   Press Ctrl + P  to display the Print tab. Click the Print button  to print 
the document.  

   11.   Close the document by pressing Ctrl +W .      

 Exercise 1-27 
 Open a document, undo, redo, and repeat editing actions.      

   1.   Open the file  Meeting Favors .  

   2.   Position the insertion point after the heading “Meeting Favors” and 
press [Enter]. Click the Undo button  to undo the insertion.  

   3.   Move the insertion point to the left of “flavors” in the first sentence of 
the second paragraph. Key  chocolate  to create the phrase “chocolate 
flavors.”  

   4.   In the same paragraph, move the insertion point to the left of “favor 
shapes.” Press F4  to create the phrase “chocolate favor shapes.”  

   5.   In the first sentence of the first paragraph, move the insertion point to 
the left of “for.” Key  favors  and press Spacebar .  

   6.   Locate “premier chocolate” in the last paragraph, and use the  Repeat  
command to insert “favors” to the left of “for your.”  

   7.   Click the Undo button  to undo the text. Then click the Redo 
button  to redo the text.  

   8.   In the last sentence of the last paragraph, replace the sentence by 
following these steps:    

 a.  Select the last sentence by pressing Ctrl  and clicking anywhere in the 
sentence.  

 b.   Key  Visit www.campbellsconfections.biz for additional information.     

   9.   Save the document as  [your initials]  1-27  in your Lesson 1 folder.  

   10.   Submit your work, and close the document.     

Exercise 1-27:
Objectives: 2–8
Required Files: Meeting Favors 
Solution File: 1-27 on the Online Learning Center.
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 Exercise 1-28 
 Select text, save a revised document, and enter summary information.  

         1.   Press Ctrl + N  to start a new document. Key the text shown in 
 Figure 1-24 . 

Figure 1-24 Campbell’s Confections’ chocolate factory tour and candy 
store is one of Butler County’s major attractions. The 
factory tour enables visitors to watch the entire process of 
candy making from melting the bulk chocolate to packing the 
individual pieces in airtight containers. The information 
provided by the tour guide is informative and educational.

If you are planning a family trip to Mercer County, be sure 
to research other attractions in the area. You are miles 
away from museums, antique shops, a forge that creates 
aluminum, bronze, and other metal gifts, and many outdoor 
activities. There are opportunities for camping, hiking, 
biking, boating, and fishing. Winter activities include 
sledding, ice fishing, ice skating, cross-country skiing, 
and snowmobile trails. Contact us for brochures and other 
information on area attractions.

      2.   Save the document as  [your initials]  1-28  in your Lesson 1 folder.  

   3.   Select and replace a word by following these steps:    

a.  Place the insertion point in the word “Butler” in the first sentence of 
the first paragraph.    

b. Double-click the word to select it and key  Mercer  to replace it.    

   4.   Select and replace text in the second paragraph by following these steps:

a.     Double-click “us” in the last line of the second paragraph.    

b. Key  the Chamber of Commerce  in place of the selected text.    

   5.   Select “miles” in the second paragraph, and key  minutes  to replace 
the text.  

   6.   Select a sentence by following these steps:    

a. Position the I-beam pointer over any sentence.    

b. Hold down Ctrl  and click the mouse button. Release Ctrl .    

c. Deselect the sentence.    

   7.   Select the first paragraph by following these steps:    

a.  Move the pointer to the left of the paragraph until it changes to a 
right-pointing arrow.    

b. Double-click the mouse button.    

Exercise 1-28:
Objectives: 2–3, 6–8
Required Files: None
Solution File: 1-28 on the Online Learning Center.
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   8.   Extend the current selection by following these steps:    

a.  Hold down Shift  and press  twice to extend the selection two lines.    

b.  Continue holding down Shift  and press End  to select the entire line.    

c.  Continue holding down Shift  and press PageDown  to select the rest of 
the document. Release Shift .    

   9.   Click anywhere to cancel the selection.  

   10.   Select noncontiguous text by following these steps:    

a. Double-click the document’s first word (“Campbell’s”).    

b.  Move the pointer to the left of the paragraph’s third line until the 
pointer changes to a right-pointing arrow. Hold down Ctrl  and click to 
select the line.    

c.  Hold down Ctrl  and select the second paragraph by dragging the 
pointer from the beginning of the paragraph to the end.    

   11.   Click anywhere to cancel the selection.  

   12.   Review the document properties, and enter summary information by 
following these steps:    

a. Click the  File  tab and choose  Info .    

b.  Click the down arrow beside  Properties  in the right pane, and click 
 Advanced Properties .    

c.  Review the data on the General tab and the Statistics tab, and click 
the  Summary  tab.    

d. Click in the  Title  text box, and key  Mercer County .    

e. Key  [your name]  in the Author text box.    

f. Click  OK . Click the  File  tab to return to the document.    

   13.   Click the Save button  to save the revised document.  

   14.   Submit your work, and close the document.      

LESSON 1 Creating and Editing a Document
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 Lesson Applications 

  Exercise 1-29 
 Key, edit, and print a document.  

      1.    Start a new document. Turn on Caps Lock mode and key  TO SALES 
ASSOCIATES:   

  2.    Turn off Caps Lock, and press Enter  to start a new 
paragraph.  

  3.    Key the text shown in  Figure 1-25 , including the 
corrections. Refer to Appendix A, “Proofreaders’ 
Marks,” if necessary.  Proofreaders’ marks  are 
handwritten corrections to text, often using specialized 
symbols.      

TIP

When Word suggests the completed 
word for “September,” you can press 
Enter  to insert the word. Remember to 

press Spacebar  after the completed word.

  4.   Edit the last two sentences of the first paragraph to read: 
     Next-day delivery and sealed moisture-proof containers are 

recommended for warm weather destination.  

  5.   Insert a comma at the end of the last sentence in the last paragraph, and 
key the following text:  and our customers expect their packages to arrive 
in perfect condition.   

  6.   In the second paragraph, delete “Fine” after “Remember” and key 
 Quality  before “chocolates.”  

Figure 1-25 Campbell’s Confections’ shipping policy changes will take 

effect immediately. Chocolate was shipped to warmer 

climates between June 1 and August 15 only. The new 

policy includes year-round shipping with Campbell’s 

confections reserving the right to postpone shipments. 

Chocolate shipped to warm climates (temperatures over 

70 degrees) will be surrounded with ice packs. A chart 

has been distributed listing the statistical average high 

temperature for each state by month. Next-day delivery is 

recommended for warm weather destinations. Use sealed 

moisture-proof containers to prevent damage caused by 

high humidity.

Remember: Fine chocolates are perishable.

Formerly

to all store managers

during 
extremely 

hot conditions

September May

are

ASSESS
Assessment Resources:
Test Bank

Lesson Applications:
Provide independent practice for 
students and may be used for 
assessment. Objectives are 
indicated for each exercise.

Exercise 1-29:
Objectives: 2–3, 6–8
Required Files: None

Solution File: 1-29 on the Online 
Learning Center.

This figure contains proofreading 
marks. You might want to review 
Appendix A, “Proofreaders’ 
Marks,” with students.
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  7.   Save the document as  [your initials]  1-29  in your Lesson 1 folder.  

  8.   Print the document, and then close it.    

    Exercise 1-30 
 Key, edit, and print a document.      

  1.   Start a new document, and key the two paragraphs shown in  Figure 
1-26 , including the corrections. Refer to Appendix A, “Proofreaders’ 
Marks,” if necessary.  

WD-45

      2.   Correct the spelling of “thru” in the third sentence to  through .  

  3.   In the last sentence of the last paragraph, key  type of  after “or any.” 
Delete “families visiting the area” and key  tourists  in its place.  

  4.   Add the following text to the end of the second paragraph:

  Reservations are required two weeks in advance with a minimum of ten 
members in the tour. To schedule a tour or for more information, call 
1-800-555-2025 or visit www.campbells.confections.biz.   

  5.   Save the document as  [your initials]  1-30  in your Lesson 1 folder.  

  6.   Print, and then close the document     

 Exercise 1-31 
 Select and edit text, and insert a nonbreaking space.  

      1.   Open the fi le  Factory - 2 .  

  2.   Split the first paragraph at the sentence that begins “The chocolate 
factory.”  

  3.   Merge the second paragraph with the third paragraph. Be sure to insert 
a space between sentences.  

Figure 1-26 Campbell’s Confections offer group tours from September 

to June. Tours include watching a video on the history of 

Campbell’s Confections as well as the history of 

chocolate. After the video, a tour thru the factory is 

conducted by the plant manager.

Group tours arranged are for families visiting the area, 

school, or any group with an interest in learning about 

chocolate.

At the end of the tour, each 
person receives a candy sample.

s

s

LESSON 1 Creating and Editing a Document

Exercise 1-31:
Objectives: 2–8
Required File: Factory - 2
Solution File: 1-31 on the 
Online Learning Center.

Exercise 1-30:
Objectives: 2–3, 5–8
Required Files: None
Solution File: 1-30 on the 
Online Learning Center.

This figure contains 
proofreading marks. You might 
want to review Appendix A, 
“Proofreaders’ Marks,” with 
students.

Point out that some documents 
will show a red, wavy underline 
for words that are spelled 
correctly but are not in Word’s 
dictionary.
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  4.   Spell out “sq.” and “ft.” Replace “all of its” with  the .  

  5.   At the end of the last paragraph, key this sentence: 

     Educational materials are available for elementary and middle school 
teachers .  

  6.   Add a nonbreaking space between “June” and “30.”  

  7.   Insert the following sentence at the end of the first paragraph. 

     The factory hosts special events throughout the year such as Candy 
Making 101 and Secrets of Dipping Strawberries. Each year Campbell’s 
Confections sponsors an expert chocolatier to demonstrate the art of 
making chocolate .  

  8.   Save the document as  [your initials]  1-31  in your Lesson 1 folder.  

  9.   Submit and close the document.     

 Exercise 1-32    Challenge Yourself 
 Select and edit text, use formatting characters, and enter summary 
information.          

   1.   Open the file  Summer .  

   2.   Revise the document as shown in  Figure 1-27 .      

UNIT 1 Basic SkillsWD-46

Figure 1-27 Summer is a great time to visit Grove City. In June, the 

Grove City Area Chamber of Commerce hosts the annual 

Strawberry Days Art & Music Festival. Enjoy free working 

exhibitions, live entertainment, and wonderful ethnic food.

The July 4 patriotic celebration and fireworks are a 

special treat. Dozens of aerial displays and fantastic 

ground displays are all part of the Fireworks Spectacular 

at Memorial Park.

In August, the Chamber of Commerce hosts Art in the Park. 

This annual event features more than 100 artisans with a 

wide variety of fine art and handcrafted treasures.

Visitors canin June

Fourth of

fantastic

   3.   Add the following sentence after “Music Festival in June” in the first 
paragraph:

  The festival features more than 75 craftspeople and artists.   

   4.   In the last sentence of the first paragraph, replace “wonderful” with  a 
wide variety of .  

Exercise 1-32:
Objectives: 2–8
Required File: Summer
Solution File: 1-32 on the Online Learning Center.

This figure contains proofreading marks. 
You might want to review Appendix A, 
“Proofreaders’ Marks,” with students.
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   5.   Change the last paragraph so it becomes three lines of text, as follows 
(use line breaks to start new lines): 

Coming in August:  
     Art in the Park  
     Fine art and handcrafted treasures   

   6.   Select the three-line paragraph you just created.  

   7.   Press Delete , and then undo the deletion.  

   8.   At the end of the first paragraph, change “food” to  foods .  

   9.   Save the document named  [your initials]  1-32  in your Lesson 1 folder.  

  10.   Open the  Properties   dialog box, and click the  Summary  tab. Key 
 Summer in Grove City   as the title, key your name as the author, and key 
 Summer tourist attractions  in the Comments box. Click  OK  .  

  11.   Save the document and submit your work.      

 On Your Own 

 In these exercises you work on your own, as you would in a real-life 
business environment. Use the skills you’ve learned to accomplish the 
task—and be creative.        

 Exercise 1-33    
    Browse the various tabs on the Ribbon until you find a command that looks 
intriguing. Use the Help feature to learn more about the feature. In a new 
blank document, write a few paragraphs about your findings. Save the 
document as  [your initials]  1-33  and submit it.   

 Exercise 1-34       
 Locate a novel or historical text written before the twentieth century. Create 
a new document, and key approximately one-half page of text using the 
historical reference you located. Save the document as  [your initials]  1-34a . 
Edit the document to change the language to a contemporary writing style. 
On the Summary tab of the Document Properties dialog box, key the name 
of the original author in the Author text box. In the Comments box, key 
Modified by   [your name] . Use the Save As command, and save the document 
as  [your initials]  1-34b  and submit it.   

 Exercise 1-35    
    Write a one-page summary about a local family-owned business. Include 
information about the company, number of employees, and products or 
services provided. Switch to Overtype mode, turn on Caps Lock, and then 
select headings or key terms to emphasize in the document. Save the 
document as  [your initials]  1-35  and submit it.                                          

On Your Own:
These exercises are entirely free-form. They do not “hold 
the student’s hand” or provide steps. No solutions are 
provided. Encourage students to be creative. You might 
assign exercises as group projects.

Exercise 1-34
Objectives: 2–3, 5–8
Required Files: None

Exercise 1-35
Objectives: 2–3, 5–8
Required Files: None

 Exercise 1-33 
 Objectives: 2–3, 5–8 
 Required Files: None 
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